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Using This Electronic Guide
Text that is underlined and colored is a “link.” Click a link to go to the
subject matter indicated by the link. Red links go to pages within this
guide. Green links, however, lead to real pages on the World Wide Web.

NOTE: All of the instructional material in this guide is accessible to
you before completing the TotalAccess registration process.
However, the green links to the Web will work only if you
are using Acrobat® Reader® Version 3.0 (the version included
on EarthLink Network’s CD-ROM), if you have already 
completed the EarthLink™ TotalAccess™ registration
process, and if you are currently online and connected 
to the Internet. For more information about how your
particular computer accesses green Web links, click the
appropriate option below:
Windows®95 Windows®3.1 Macintosh®

Click an Arrow to move to the next page. (Some arrows have text
that explains to which page they “jump.”)

Email

webtour

Example of how
links appear

throughout this
document.  

Note: this is not 
an actual link.

Example of arrow
links that appear
throughout this

document. 



Accessing Web Links: Windows 95
In order to access green Web links, you must already be connected online to EarthLink
Network. But even if you are offline, the rest of this electronic guide will still be 
completely available to you. 

Choose the Web browser that was installed on your computer during the
EarthLink TotalAccess registration process: Netscape Navigator™ or 
Microsoft Internet Explorer™.

Return to Using This Electronic Guide.



Accessing Web Links: 
Windows 95 and Netscape Navigator
After you click a green Web link, Netscape Navigator will open a new window
displaying the link’s Web site. When you are finished looking at the Web site,
choose the Acrobat Reader icon from the Windows 95 taskbar at the bottom of
the screen to return to this electronic guide. 

Then, the next time you click a green Web link, you must then go to the Windows 95
taskbar at the bottom of the screen and choose the Netscape Navigator icon to bring
into view the browser window showing the new Web site.

If you ever want Acrobat Reader to use a different browser to open Web links, open
Acrobat Reader, click on File, and choose Preferences.  Choosing Preferences will
open a menu, from which you should choose Weblink.  In the pop-up screen which
appears, locate Connection Type; your current browser will appear in this blank.  
Use the arrow to the right to scroll through a list of possible browser choices; simply
select the browser you wish to use, then click OK.

Return to Using This Electronic Guide.



Accessing Web Links: 
Windows 95 and Microsoft Internet Explorer
After you click a green Web link, Netscape Navigator will open a new window
displaying the link’s Web site. When you are finished looking at the Web site,
choose the Acrobat Reader icon from the Windows 95 taskbar at the bottom of
the screen to return to this electronic guide. 

Then, the next time you click a green Web link, you must then go to the Windows 95
taskbar at the bottom of the screen and choose the Netscape Navigator icon to bring
into view the browser window showing the new Web site.

If you ever want Acrobat Reader to use a different browser to open Web links, open
Acrobat Reader, click on File, and choose Preferences.  Choosing Preferences will
open a menu, from which you should choose Weblink.  In the pop-up screen which
appears, locate Connection Type; your current browser will appear in this blank.  
Use the arrow to the right to scroll through a list of possible browser choices; simply
select the browser you wish to use, then click OK.

Return to Using This Electronic Guide.



Accessing Web Links: 
Windows 3.1 and Netscape Navigator
The first time you click a green Web link, Acrobat Reader will ask you to specify
the Web browser you want to use. This will require you to locate the .exe file of
your Web browser (Netscape Navigator). You can usually find this .exe file inside
the Program folder located inside the Netscape folder. The file is called
Netscape.exe or simply Netscape and has a Navigator icon. Selecting your Web
browser is a one-time chore. Every time afterward, Acrobat Reader will automatically
launch your Web browser when you click a green Web link.

When you are finished looking at the Web site, Minimize the Netscape Navigator
window to return to this electronic guide. 

Return to Using This Electronic Guide.



Accessing Web Links: 
Macintosh and Netscape Navigator
The first time you click a green Web link, Acrobat Reader will ask you to specify the
Web browser you want to use. This will require you to locate your Web browser
(Netscape Navigator). You can usually find this file inside the Netscape Navigator
folder located inside the TotalAccess folder. Selecting your Web browser is a one-time
chore. Every time afterward, Acrobat Reader will automatically launch your Web
browser when you click a green Web link.

After clicking a green Web link, Netscape Navigator will open a new window display-
ing the link’s Web site. When you are finished looking at the Web site, just use your
mouse to click inside the Acrobat Reader window to make this electronic guide the
active application. 

Return to Using This Electronic Guide.



The window to the left contains “bookmarks.” These bookmarks form
a complete table of contents for this guide. Click any bookmark with
your mouse to go directly to that page. 

Click the Go Back button on the toolbar to return to the last 
page visited.

Click the Next Page button on the toolbar to advance to the next page
of this electronic guide.

Click the First Page button on the toolbar to go back to the first page
of this electronic guide. 

This is the Window Splitter. Drag it to the right to increase the
size of the bookmarks window. 

For more information on using this Acrobat Reader program,
read the “help” file that comes with the Reader program.
Windows users can access this file by simply pulling down the
Help menu and choosing Help-Reader.pdf. Macintosh users 
need to go to the File menu, choose Open, and then select the file
Help-Reader.pdf. It will be located in the Help folder that is
inside the Adobe Acrobat folder on your hard drive. 



Who Should Read 
This Electronic Guide 

If you are new to the Internet, you will want to take a close look at this entire
electronic guide. Part I: Welcome to the Internet! is a broad overview explaining
how the Internet works and what you can do on it. Part II: Getting Started
provides the technical information you will need to connect to the Internet
through EarthLink Network®.

If you are an experienced Internet user, but are new to EarthLink,
Part I: Welcome to the Internet! may be useful as a refresher course. However,
be sure to focus on Part II: Getting Started, which provides specific information
about connecting through EarthLink. 



A Letter from 
EarthLink’s Founder

Dear New EarthLink Customer,

The Internet has become the most incredible communications medium the world
has ever seen, but it is only useful to the degree that we understand it and make it
work for us. I founded EarthLink Network to help people turn the Internet into a
valuable resource. Our mission is to make the Internet a productive and enjoyable
part of your life.

This electronic guide provides a simple introduction to some of the things you
can do on the Internet. It’s not a manual for the software you will use to access
the Internet; rather, it’s a brief tour of the most popular Internet activities, with
some helpful tips for getting the most out of your Internet connection.



I’ve included some examples that are specific to EarthLink’s Internet service,
but the principles are applicable anywhere on the Net.

I’m sure you’re ready to learn more about the Internet—so use your mouse to
click the arrow below and let’s get started!

Sincerely,

Sky Dayton
Founder and Chairman,
EarthLink Network, Inc.

P.S. 

I almost forgot to introduce you to bLink;
this little robot will be your “tour guide”
throughout this electronic guide. 

bLink is the EarthLink mascot and, as you
will soon see, a complete expert on all
things relating to the Internet. 



The Internet—at first glance it can seem like a strange, unknown world. But don’t
worry; you’ll realize that the natives can be quite friendly! 

Part I of this guide will provide you with a neighborly introduction to some of the
major institutions in this new “global community.”

Click any of the items below to learn more about that particular aspect of the Internet:

Introductory Information

The World Wide Web

Email

Usenet

(If you are looking for information on installing EarthLink 
Network TotalAccess software, go to Part II: Getting Started.)

Part

I

Welcome to

the Internet! 

The idea of a 
“global community”

is now a reality.



Introductory Information
Click the topics shown below to learn introductory information about the Internet and
how you’ll connect to it through EarthLink Network:

What Is the Internet?
How it got started, how it works, and where it’s at now.

Your Connection to EarthLink
Modems, POPs, onramps to the Information Superhighway,
and important stuff like that.

Getting Connected for the First Time
“Buckle your seat belt, Pa, the modem’s starting to make funny noises….”



What Is the Internet?
The Internet began in the late 1960s as
an experiment by the U.S. Department
of Defense to see if a non-centralized
network could be built to withstand
the destruction of one or more of its
parts. Unlike previous networks, this
new network did not have a single
central point. Instead, all sites on the
network were interconnected. 

Out of this network came a protocol for
linking computers together. A protocol is
a set of standards for how network com-
munication takes place. The protocol is
called TCP/IP (Transmission Control
Protocol/Internet Protocol). This proto-
col is the standard that makes it possible
for different computers all over the
globe to talk to each other. The TCP/IP
protocol is the foundation of the Internet. 

Old

New

all sites interconnected 
with each other

central hub site

remote 
sites



At first, the Internet was used solely by the government, but soon universities and other
institutions connected themselves to the Internet to communicate with one another and
collaborate on projects. The Internet grew to connect hundreds of different sites all
across the world. Each organization on the Internet was responsible for maintaining its
part of the network, so the Internet was not owned or controlled by any one organization.

In the late 1980s, businesses began connecting to the Internet in large numbers. 
In the following years, the Internet experienced (and is still experiencing) its most
explosive growth period, as individuals
all over the world began to want per-
sonal Internet access. To respond to 
this demand, access companies sprang 
up, offering dial-up modem access 
to the Internet. EarthLink Network is
one of the largest of these companies. 
We provide direct access to the Internet
for people with modems.

Today, the Internet connects up to 40
million people around the globe and is
growing by as much as 10% per month. The military saw 

the strategic value of a 
non-centralized computer network.



Your Connection to EarthLink
The Internet is like a system of roads, freeways, and bridges. Although I like to avoid
the over-hyped term “Information Superhighway,” it is a decent metaphor for how the
Internet works. From any road in any city, you can get to almost any other road in any
other city. From my computer at my desk, I can send an electronic mail message to
someone sitting at a computer in Helsinki, Taipei, or Biloxi.

EarthLink and other Internet access companies provide “onramps” to the Information
Superhighway—physical connections that allow you to access the Internet. EarthLink
has built fast onramps in hundreds of cities. These onramps are called “POPs,” which
stands for “Points of Presence.” We have a POP in every major city in the United
States and Canada, with additional POPs being added almost weekly. 

Your computer uses a modem to dial into one of our POPs which connects you to the
Internet. Once connected to an EarthLink POP, you have access to all the resources 
of the Internet. EarthLink has also supplied you with software available for “surfing”
the Internet: a Web browser.



Getting Connected for the First Time
After you have registered your account and installed your Internet software using the
EarthLink Network TotalAccess software, you will need to connect your computer to
an EarthLink POP using your modem and phone line.

To do this, you’ll open EarthLink’s Internet Dialer software and click Connect to 
activate your modem. (Depending on the type of computer you have, the steps of the
connection process may vary slightly.) Once your dialer logs you into EarthLink
Network, you are connected to the Internet.

Then you can open your Web browser to start surfing the Internet.

Note: If at any time you experience difficulties with your computer or TotalAccess
software, please refer to Part II: Getting Started.



The World Wide Web
The World Wide Web, or “the Web” for short, is the part of the Internet that allows
you to navigate through all kinds of graphical information. To explore the Web, you’ll
use a Web browser, which is supplied by EarthLink within your TotalAccess package.
Depending upon which version of TotalAccess you have received, either Netscape
Navigator or Microsoft Internet Explorer will be installed on your computer. Both are
easy to use, powerful Web browsers.

Click any of the subjects shown below to access an explanation of that topic:

Introduction to the Web
“OK, if it’s called ‘the Web,’ how can it have ‘pages’?”

Finding Things on the Web
“I love collecting weird buttons; are there any Web sites for people like me?”

If You Like It, Bookmark It
“Gosh, I remember seeing that great Traffic Report Web page, but now 
how do I get back to it?”

Creating Your Own Web Page
“Look, Mother, our little Maynard is online for the whole world to see!”



Introduction to the Web
Information on the Web is formatted into
“pages.” Each page contains some text and
possibly pictures, sound, or even video. A
page is actually a file stored on a remote
computer somewhere on the Net. A remote
computer that stores a Web page or other
information is called a “host.”

For example, here’s the address of EarthLink’s homepage:

http://www.earthlink.net/index.html

This address has the following elements:

http://

Stands for “HyperText Transport Protocol,” the protocol, or standard, used on the Web.
http:// indicates that the address is for a Web page.

www.earthlink.net

The name of the host machine for the Web page.

/index.html

The name of the actual Web page file. The .html suffix stands for “HyperText
Markup Language,” which is the format used to create Web page files.

A URL is like a building’s 
street address.



All together, this address provides the exact location of a page on the Web. To
visit a page, type its address into the Netsite: blank (Netscape Navigator) or the
Address blank (Microsoft Internet Explorer) of your Web browser. Then press
Return and your browser will find the Web page file, and display it for you.

There is a term for a Web page address: “URL.” This stands for “Uniform Resource
Locator,” which means that all Web addresses follow a standard format that can be
understood by all Web browsers all over the world. A URL can be used for almost 
any Internet address, not just Web pages. The letters http:// appear at the 
beginning of a URL for a Web page (as explained above), but a URL for another 
type of information on the Internet might start with something else.

Links let you jump 
from page to page.



Most of the time, however, you won’t have to worry about specific Web page
addresses. The Web allows you to “hyperlink,” or “link,” from page to page. When
using your browser, clicking on any text that is colored and underlined will usually
link you to another page, which will be automatically retrieved and displayed.

EarthLink has a great beginner’s tutorial on how the Web works. You can access it by
going to http://www.earthlink.net/webtour/ Be sure to check it out!

Surfing the World Wide Web
is like traveling to strange,

new places without ever 
leaving home.

http://www.earthlink.net/webtour/


Finding Things on the Web
EarthLink provides an easy way to find something
on the Web: EarthLink’s Search page.  The URL is
http://www.earthlink.net/search/

You can also reach it by clicking on the 
Search link on EarthLink’s homepage.
(Netscape Navigator users can simply click 
on the Search toolbar button.)

You don’t have to be a 
detective to find 

things on the Web.

http://www.earthlink.net/search/


When you access the EarthLink Search page, your browser will present a variety of
search engines (such as Yahoo!™, Infoseek™, and Excite™) for you to use.  Open
one of these search engines, type in two or three words that describe what you are
looking for, and click the Search or Seek Now button.

Searches are generally fast, and you will soon be presented with a page listing all of
the matches found from your search.  A match is called a “hit.” Usually, you will be
given a list of up to 20 hits.  If you scroll down, you will have the option to see more
hits, if there are any.

The name of each listing is a hyperlink.  You can click on the name to access the doc-
ument.  Typically, underneath each link is a brief description of the document.

Keep in mind that a general Search will search the entire Internet for hits, while an
Excite-based EarthLink Search will search EarthLink’s site specifically.

You might come up with some bizarre stuff.  If needed, you can always narrow down
your search with some different search words and try again.

If you get lost, just use your Back button (or Netscape Navigator users click the
Search button) to return and start over.

http://www.earthlink.net/search/


Besides browsing the Web with search engines, EarthLink’s Search page also
offers you the opportunity to use subject-based directories.  Using a directory is 
a lot like using the Yellow Pages—you search by subject.  Just start browsing
through the directories until you find one of interest.  Then click it, and multiple
sites and sub-directories will
appear for further investiga-
tion.  For example, clicking
on Yahooligans! for kids
from the Yahoo! directory
will take you to a listing of
Web sites designed especially
for children.

Remember, you can go back
to the previous page simply
by clicking the Back button
in the upper left-hand corner
of your Web browser.  If you
get lost, return to the Search
page and start over.

http://www.yahooligans.com


If You Like It,
Bookmark It
When you find a page on the Web
you think you might want to look at
again later, you can “bookmark” it.
Using Netscape Navigator, select Add
Bookmark from the Bookmarks
menu. The name of the page will 
then appear at the bottom of the
Bookmarks pull-down menu. Using
Microsoft Internet Explorer, select
Add Page to Favorites from the
Favorites menu. The name of the page
will then appear at the bottom of the
Favorites pull-down menu.

If you do this a lot, you will soon end up with a long list of bookmarks. 
Your browser allows grouping and indexing, so cataloging them is easy. 
You can even trade bookmark/favorite files with friends.

Just like a book, Web pages 
can be easily bookmarked.



Creating Your Own
Web Page
Browsing the Net for information is often
called “surfing.” Once you’ve surfed for a
while, you might decide you’d like to see
your own name in lights and create a
homepage for yourself.

You’re in luck! Your EarthLink account
includes your own directory on our
Web server. You can create your 
own Web site and put it on the Net 
so anyone in the world will be able 
to access it on the Internet.

In order to construct your own Web site or
personal homepage, you will need to cre-
ate HTML (HyperText Markup Language)
documents. An HTML document provides
the directions that tell a Web browser 
how to format the contents of a page for
viewing. As its name probably suggests, HTML takes a little effort to learn. 

Introduce yourself to the 
whole world with a homepage!



There is a simple introduction to HTML called “A Beginner’s Guide to HTML,”
which is available inside EarthLink’s Creating Web Pages area. To get to 
this and other documents that provide HTML examples, tips, and tutorials, first
click the Creating Web Pages link on EarthLink’s homepage. Next, choose 
the How to Create Web Pages link, and then the HTML link. Or, enter 
http://www.earthlink.net/nethelp/creating_web_pages.html

in your browser. After you enter the URL, hit Return.

You could also use a Web page authoring program, such as Netscape Navigator Gold™
(obtained at http://home.netscape.com/comprod/mirror/) or Microsoft
FrontPage™ (obtained at http://www.microsoft.com/frontpage/). These
programs make composing HTML documents almost as easy as using a word processor.

http://www.earthlink.net/nethelp/creating_web_pages.html
http://www.microsoft.com/frontpage/
http://home.netscape.com/comprod/mirror/


Email
Electronic mail (email) is far and away the most popular aspect of the Internet. You
can send an email message from your computer to anyone else on the Internet with an
email address. This section will provide an introduction to email and some tips on how
to get the most out of this new form of communication.

Email Addresses
“Honest—those weird symbols and abbreviations do mean something!”

Getting Your Mail
“Yes, Mrs. Robinson, you need to be online before you can download your email.”

The Continuing Email Message
How to keep track of who says what and when they say it.

The Smiley
Emotionally repressed? “Take two smileys and call me in the morning.”

The Signature
It isn’t really a written signature, but a listing of your address and phone number.

Different Signature Formats from People on the Net
Playful artist or no-nonsense businessperson? Say it with your signature.



Email Addresses
Any email address has three basic parts:

1) The name of the user,
the “username.”

2) The name of the computer where 
the user’s email account is located,
the “hostname.”

3) The @ or “at” sign, separating the 
username from the hostname.

Here’s an example using my email address:

sky@earthlink.net

sky is my account name, or username;

@ means my email account is “at” a particular host;

earthlink.net is the hostname of the computer where 
my emailbox is located.

Email: Nearly 
instantaneous 

delivery, and no need 
to lick a stamp!



earthlink.net is actually a battery of high-speed computers sitting in the
EarthLink Network data center. These computers contain thousands of electronic 
mail accounts, also called “mailboxes.” They receive and store your email until you
log into an EarthLink POP and ask your mail program to check your mail.

Email addresses come in all shapes and sizes, but they always follow this format.

The suffix at the end of the address indicates what kind of host server the user’s
account is on, or possibly what country the host server is located in. For example, your
EarthLink email address ends in “.net”. This indicates that EarthLink is a network.
Other popular suffixes include:

Country suffixes are optional; a site in Spain could still have “.com” as its suffix.

Your email address will be your username followed by @earthlink.net 
If you give this address to anyone on the Internet, they’ll be able to send you email.

.com company 

.gov government 

.mil military 

.org non-profit organization

.ca Canada 

.it Italy 

.jp Japan



Getting Your Mail
You will probably use your browser to get and read your mail. The program goes out
across the Internet and picks up your mail from EarthLink’s mail servers.

If you have any mail waiting for you, your mail program will download the messages
to your computer and allow you to read them. (If your browser is Netscape Navigator,
see Setting Up Netscape Navigator for further information, or access Netscape’s
excellent online handbook. If
you are using Microsoft Internet
Explorer, see Setting Up
Microsoft Internet Explorer.)

This is not a detailed manual on
how email works, but I would
like to provide a few tips on how
to effectively communicate with
email. Once you have learned
how to send and receive email
messages, these handy tips may
help you look like a pro. EarthLink’s mail

servers sort 
email into the 
correct mailboxes.

http://home.netscape.com/eng/mozilla/3.0/handbook/


The Continuing 
Email Message
Email messages often form 
a continuing conversation. You
will send an email message 
and receive a reply with addi-
tional questions or comments,
to which you may then
respond. This is especially 
true when you are sending 
a message to more than one
person. To avoid confusion 
in these continuing email
conversations, it is helpful to
follow a few simple guidelines.

Here is an example of an email conversation. Let’s say that your name is Mike. 
You’ve received a message from your friend, Jane. She also sent the same message 
to a mutual friend named Bob:

“If you get to Mo’s first,
order me a decaf latte.”



Mike & Bob,

Let’s meet for coffee on Saturday at Mo’s.

Let me know a good time for both of you.

Jane

When you select Reply in some email programs, you get a new message window that
includes the original message. (Netscape Mail users will need to press the Quote
button on the reply form to include the original message.) Each line of the original
message begins with a “>” character, like this:

>Mike & Bob,
>
>Let’s meet for coffee on Saturday at Mo’s.
>
>Let me know a good time for both of you.
>
>Jane

There are several ways to compose a reply to the original message. 



First method: Write your reply above the original message:

Jane,

Sounds great. 5 p.m. is good for me.

Mike

>Mike & Bob,
>
>Let’s meet for coffee on Saturday at Mo’s.
>
>Let me know a good time for both of you.
>
>Jane

Second method: Write your reply below the original message:

>Mike & Bob,
>
>Let’s meet for coffee on Saturday at Mo’s.
>
>Let me know a good time for both of you.
>
>Jane

Jane,

Sounds great. 5 p.m. is good for me.

Mike



Third method: Intersperse your reply after each paragraph of the original message:

>Mike & Bob,
>
>Let’s meet for coffee on Saturday at Mo’s.

Sounds great.

>Let me know a good time for both of you.

5 p.m. is good for me.

Mike

>Jane

The first two approaches are best suited for simple messages. The last method is 
useful if you want to separately reply to specific parts of the original message, or 
if the original message is long.



The need for a good format is obvious when a third person joins the conversation.
Every time someone replies to a message, another “>” character is placed before each
line. This way, it’s easy to discern the original message from each subsequent reply:

>>Mike & Bob,
>>
>>Let’s meet for coffee on Saturday at Mo’s.
>
>Sounds great.

Same here.

>>Let me know a good time for both of you.
>
>5 p.m. is good for me.

5 p.m. is fine for me, too.

See you there!

Bob

>Mike
>
>>Jane



While the previous example shows how an email conversation among several people
works, it looks confusing. It would be better if each message had been kept together:

Jane,
OK. See you at 5 p.m.
Bob
>Jane,
>
>Sounds great. 5 p.m. is good for me.
>
>Mike
>
>>Mike & Bob,
>>
>>Let’s meet for coffee on Saturday at Mo’s.
>>
>>Let me know a good time for both of you.
>>
>>Jane

There are other ways to bring clarity to an email exchange. You can delete parts of 
earlier messages that are no longer applicable. What’s more, some mail programs 
help matters by inserting text before each quoted message to indicate who wrote the
message, like this:

At 3:45 PM 11/15/96, Mike Smith wrote:

There are no set rules for organizing an email conversation, but these 
few suggestions will make your messages more readable.



The Smiley
Email makes it possible to communicate inexpensively 
and instantly to someone anywhere in the world, but the
expression is confined to written words. Written words lack
the richness we get in live communication through tone 
of voice, facial expression, and emotion. Without these 
personal indicators, it’s easy to misinterpret the meaning 
of an email message.

To give email some of the flexibility and richness of spoken
communication, you can use “smileys.” Smileys are charac-
ter representations of facial expressions. (At first, you may need to tilt your head
to the left in order to “read” a smiley’s facial expression.) They are entered in
appropriate places in the text of a message to indicate the author’s emotion. 

Here’s a line of email text with a smiley:

It was great seeing you again. :-)

The smiley adds special emphasis to the statement. Smileys are especially helpful
when you are joking or being sarcastic.

Smileys let 
others know how 

you really feel.



If you write

Like I’m going to work really hard on my birthday.

your recipient might think you really meant this. But, if you say

Like I’m going to work really hard on my birthday. ;-)

the winking smiley tells the reader that you are kidding around.

Smileys are so popular on the Internet, you can even find smiley dictionaries:

The Smiley Dictionary
http://www.netsurf.org/~violet/Smileys/

The Unofficial Smiley Dictionary
http://www.cuhk.hk/bdgtti2.2/bdg_290.html

Here are some popular smiley examples:
:-) happy
:-D very happy
:-( sad
;-) wink
:.-( crying
:-| indifferent
:-& tongue-tied
%-\ perplexed
:-# wearing braces

(-: left-handed
8:-) little girl
@:-) curly hair
[:] robot
:-[ vampire
:<) Ivy Leaguer
B-) horn-rimmed glasses
8-) wearing sunglasses
B:-) sunglasses on head

http://www.netsurf.org/~violet/Smileys/
http://www.cuhk.hk/bdgtti2.2/bdg_290.html


The Signature
Unlike other written correspondence, an email message can’t be printed on your letter-
head. If you want people to know your name, “snail mail” (postal) address, and phone
or fax number, you need to include them in your message.

Putting this information in an email “signature” is a simple way to do this. Most mail
programs allow you to set up a signature that will be automatically attached to the end
of your email message. Depending on what email program you are using, you might
not see the signature while you are typing the message; it will be added by the mail
program while the message is being sent.

You can design your signature any way you like, but a good rule of thumb is not to
exceed eight lines. Otherwise, it will be bulky for your recipients.

Once you feel comfortable with email, you can set up a signature for yourself.
For instructions on how to set up a signature, choose one of the following
options: Microsoft Internet Explorer or Netscape Navigator .



Different Signature Formats 
from People on the Net 
Business signature:

Sky Dayton, Founder & Chairman | Voice: 818-296-2400

EarthLink Network, Inc. | Fax: 818-296-4161

sky@earthlink.net | 3100 New York Drive

http://www.earthlink.net | Pasadena, CA  91107

Signature with a favorite quote:

====================================================

| david a. tribble |               |

| datrib@jpl.nasa.gov | “This moment  |

| VMT 300-319 |    contains all moments” |

| Montrose, CA 91109 |    |

| (818) 555-1212 |  -- C.S. Lewis |

| (818) 555-1213 (FAX) |     *The Great Divorce* |

====================================================



Signature showcasing artistic talents:

,-~~-.___. <---------------------------------->

/ |  ‘     \    -=| Henry Franks        |=-

(  )         0  -=| ab333@broadway.sfn.sk.ca |=-

\_/-, ,----’    -=| (306)-555-1212 Saskatoon, |=-

====         // -=| Saskatchewan, C A N A D A |=-

/  \-’~; /~~~(O) <---------------------------------->

/__/~|   / IBM | Check out my home page!!!

=( ____|  (_______| http://www.sfns.ca/~ab333/Profile.html



Usenet
Usenet is a part of the Internet that provides discussion groups on about 22,000 differ-
ent topics. It works like a bulletin board: someone posts a message to the group for all
to see, and then anyone can post a follow-up message. A message and its follow-up
messages on a certain topic are called a “thread.”

For some time, the official name of these 
discussion groups has been “Usenet news,”
or just “news” for short. A discussion group
on Usenet is called a “newsgroup.”

Usenet provides a place for people with
specific interests to discuss a certain topic.
Usenet newsgroups can be very specific.
For example, there is one newsgroup
devoted solely to discussions about
unicycling. Another focuses on
Disney’s afternoon cartoons.

“But how do
I get off?”



Click the topics below to access more information about using Usenet:

Accessing Newsgroups
How to use your browser to read and post to Usenet groups.

Pitfalls of Usenet
“Partner, it’s a wild frontier out there—beware of spamming and flaming!”

Netiquette, the Rules of the Road
“Mind your Ps and Qs, chew with your mouth closed, and don’t write 
sentences IN ALL CAPITAL LETTERS!”

The Structure of Usenet Posts
Learn how to do it the right way—the first time.

Finding Newsgroups that Fit Your Interests
Whether you love watching Beavis and Butt-head or collecting 
snapping turtles, there’s sure to be a newsgroup for you.

The Structure of Usenet Group Names
“OK, the group is called alt.baldspot—now what do they talk about?”



Accessing Newsgroups
You can use your browser to access Usenet news. If Netscape Navigator is your
browser, access newsgroups by selecting Netscape News from the Window menu.
Microsoft Internet Explorer users can simply click on the Mail icon at the top of 
their screen and then choose Read News.

Using your browser, you can get a list of certain popular groups by clicking on
the Newsgroups link from the EarthLink homepage. It will bring up a list of
popular sets of newsgroups by various categories. Once you have the list of
groups, click on one to see a catalog of its articles, then click on the articles 
to read them. If needed, see Netscape News or Microsoft Internet News for
additional help on accessing newsgroups.



Pitfalls of Usenet
The Internet, and Usenet specifically, provides a
new kind of freedom of communication. Before 
the Internet, it was difficult and expensive to have
your voice heard by a large number of people. With
Usenet, you can be heard instantly by thousands of
people at virtually no cost.

With this freedom comes responsibility.

In the past couple of years, many people have taken
advantage of this freedom and not taken their share of
responsibility. They have abused Usenet and made it
more difficult for others to use it. For example, a num-
ber of Internet users knowingly post messages that have nothing to do with the subject
of the newsgroup to which they are posting. This is like standing around and talking
about fly-fishing with some people you’ve just met, and suddenly, someone starts
yelling that they’ve got a great recipe for stuffed yams. They may have good inten-
tions, but their message is clearly out of place.

Spamming: “Hey buddy,
wanna buy a watch?”



Others have even posted messages advertising products or services to dozens,
hundreds, or even all Usenet groups. The practice of posting messages (usually
of a commercial nature) to many Usenet groups at once is called “spamming.”

Posting off-topic messages and spamming usually result in some form of retaliation by
the other participants of the discussion group. Such retaliation, because of its abrasive,
heated nature, is called a “flame.” A flame can erupt into an all-out flame war, which, if
carried on in the newsgroup, is like eating in a nice, quiet restaurant and seeing a brawl
start up at the table next to you. It’s hard to avoid being pulled into it, you can’t finish
your dinner, and the ambiance of the restaurant has completely disappeared.

Factors such as spamming and flaming have made Usenet a bit like the Wild West.
There’s no sheriff, so people usually turn to vigilante justice in an attempt to keep
their favorite groups free of spamming, impolite intruders.



Netiquette, the Rules of the Road
All of us have a responsibility to uphold certain rules when participating in Usenet 
discussion groups. By doing so, we will make Usenet a more useful resource for
everyone. These rules are often called “Netiquette.”

Here are my top ten rules of Netiquette for Usenet:

1) Spend time “lurking,” or watching, a newsgroup before you post for the first time.
Every group has its own small moral structure. The more you watch, the more
you’ll be able to effectively contribute when you speak for the first time.

2) Before asking a question in a newsgroup, see if you can find an answer in that
group’s “Frequently Asked Questions” (or “FAQ” for short). FAQs are documents
maintained by enthusiasts of a particular newsgroup. They contain basic informa-
tion on the group and its purpose. 

Sometimes there is more than one FAQ for a particular group, especially if the
group is populated by people with opposing views. FAQs were created to cut down
on the questions that new users (called “newbies”) often post in newsgroups. If
you can’t find a FAQ, go ahead and ask your question.

3) No matter what, you will eventually get flamed, so get used to the idea now. 
No matter how careful you are, you are bound to step on someone’s toes



and make them upset. The result will probably be
a rude note in your emailbox the next day or a
nasty post about you in the newsgroup. For
example, a new user might post a message that
uses all uppercase letters—the Internet equivalent
of prolonged yelling and a breach of Netiquette.
Even if the newbie didn’t know enough to avoid
the mistake, there are people out there with 
nothing better to do than flame others.

The best way to respond to a flame is not to respond
at all. But if you can’t resist the urge to flame back,
stop what you are doing and go take a walk. If after
you do this you still want to flame back, do it 
privately by email and not through the newsgroup.
The others in the group who are trying to get on
with life will be glad you did.

4) If you see a posting by a new user that is off-topic or silly in some way, do every-
thing possible to be polite. Kindly send the user a note by email explaining what
they did wrong. Don’t flame.

Spammers often
get flamed—badly.



5) If you see a blatant advertisement that doesn’t belong in the newsgroup, send the
user a note by email. Be polite. Don’t post a follow-up message, as this will just
clog the newsgroup and give the spammer more attention than they deserve.
Spamming by EarthLink customers can also be reported to EarthLink officials by
writing to abuse@earthlink.net

6) Follow the thread. If you are reading a thread and want to post a follow-up, make
sure it is directly related to the existing thread. If not, start a new thread by posting
a new message. Don’t disrupt the thread for others.

7) Unless you have permission from the author, don’t quote an email or other private
message in public discussion groups. People often say things in private they
wouldn’t say in public. It’s no different on the Internet.

8) Don’t post copyrighted or private information on the Net. There is a legal issue
here, but there is also an ethical one. You shouldn’t use the copyrighted or private
information of another without their permission.

9) Don’t waste resources and time posting “me, too” responses. If the only public
response you can offer is simple agreement, then don’t. It takes up space and adds
nothing to the thread of conversation. But feel free to answer the person via email.
Everyone appreciates being acknowledged, and you could make a fast friend. 



10) No matter what, be nice. Don’t lose your temper—ever. Be polite and cordial, no
matter how rude and obnoxious the other poster is. If you need to be abrasive, do
so by email, but don’t post to the whole group. You will quickly gain the respect 
of other civilized users of a discussion group by proving you can’t be taunted into
losing your cool.

These rules are especially applicable to Usenet, but many of them hold true for all
Internet activities. Like any new culture where people live and work together, the
Internet is evolving its own moral and cultural structure. 

Netiquette is the grease in the machinery of human interaction on the Internet.
The more you understand these simple guidelines, the better the Internet will
work for all of us.



The Structure of Usenet Posts
Below is a sample post I pulled off of the unicycling newsgroup mentioned earlier. 

This message is a good example of the proper use of Usenet. The subject is on-topic,
and the tone of the participants is helpful and polite. You can also see how the thread
flows from the original message to the reply:

In article <v02130500ad3bc7c6543f@[129.74.34.157]>, 
Barney Dreds <Barney J. Dreds.1@rd.edu> wrote:

>I have a Schwinn 20" and a 24". I replaced the tire on
>the 20", but the 24" has an odd size. It says that it
>is a 24"-1.75" tire, but this is a drastically different 
>size than the ones you buy at the store now. They must 
>be measuring to the inside diameter or something. Anyway,
>I was wondering if anyone can offer any suggestions.
>
>Also I was wondering if the new Schwinns are built the
>same as the old ones, and if so, if Schwinn has resumed
>making the special 14" saddle post?

I recently got a Schwinn, and found that the seat post
was just a little bit too small for me. 



So I took it to the local bike shop that will work on
unicycles and they called around. They discovered that
Schwinn is supposed to start manufacturing the longer
seat post again in about mid-February, which is about 
a week away.

Hope this helps,

Stephanie
—
Stephanie Bean
sbean@tmtc.Central.Sun.COM

The Laws of Physics Do Not Apply To Me.

You can see from this example that a Usenet post has many of the same elements as 
an email message. It contains the original message with “>” characters before each
line, the follow-up message, and the signature of the person who posted the follow-up.

At the top of the message, the original article’s serial number is provided. Unless you
are going to really nerd out, you don’t need to understand this number. After the serial
number, the email address of the author of the original post is also listed.

Smileys are also used in Usenet and are especially useful since 
Usenet messages are read by many people, all with different 
viewpoints, emotions, attitudes, and responses.



Finding Newsgroups that Fit Your Interests
If you’re new to the Internet, the best way to find a newsgroup that fits your interests
is to use a search engine.  First, go to EarthLink’s Search page. (The page’s URL is
http://www.earthlink.net/search/, or Netscape Navigator users can
simply click the Search tool button.) Next, choose Infoseek, type in a chosen 
subject, choose Usenet Newsgroups from the list of searchable options, click
Seek Now, and start surfing. Choose a link to click on, and your browser will
show you the newsgroup articles. 

http://www.earthlink.net/search/


For powerful newsgroup searches, I recommend the Usenet search engine
DejaNews™, located at http://www.dejanews.com/

If you already know the exact name of the newsgroup you’re looking for, you can go
right to it with your Web browser.

http://www.dejanews.com/


The Structure of Usenet Group Names
To find a newsgroup you might be interested in, you need to know how to read 
a newsgroup name. Here are some examples of newsgroups available on Usenet,
along with their descriptions:

Most newsgroups are classified into standard sets. The set the newsgroup belongs to 
is indicated by the first word, or abbreviation, before the first period in the name. Here
are the major set names and a description of each:

comp. computer soc. society and culture
rec. recreation misc. miscellaneous
alt. alternative newsgroups sci. scientific

(by far, the largest of 
all newsgroup sets)

alt.fan.letterman

David Letterman fans

alt.games.dominos

dominos enthusiasts

comp.robotics.research

computer robotics research

soc.culture.welsh

Welsh culture

rec.sport.unicycling

unicycling



These words describe a newsgroup in greater and greater detail. For example,
the newsgroup devoted to network administration for the computer operating 
system Windows NT looks like this:

comp.os.ms-windows.nt.admin.networking

There’s a Usenet group 
for almost anything.



Part II of this electronic guide provides directions 
for using EarthLink Network TotalAccess™
software to connect to EarthLink 
Network and the Internet. Click the 
appropriate category below to read the 
section that pertains to your computer:

TotalAccess Registration for Windows   95

TotalAccess Registration for Windows   3.1

TotalAccess Registration for Macintosh 

Part

II

Getting

        Started 


®

®

®



Part II also includes instructions on how to use various kinds of software and
EarthLink services. To learn more about one of the topics below, click on its name:

Setting Up Netscape Navigator 3.0

Settings for email, newsgroups, signature files, cache folders, and lots more.

Setting Up Microsoft Internet Explorer

Settings for email, newsgroups, signature files, cache folders, and lots more.

Setting Up Eudora Light™
A free, easy-to-use email program that you can download from EarthLink.

How to Contact EarthLink
Postal addresses, email addresses, and phone numbers for all your needs.

Additional EarthLink Programs and Services
Information on free customer Web space, faster Internet access,
customized TotalAccess software and lots more.

Glossary
“What is a ‘thread’ and why do I have to stick to it?”



TotalAccess Registration 
for Windows 95

Click the topics below for further information:

How to Install TotalAccess Software

The Online Registration Process

Completing Registration

Using Your Account

Troubleshooting

Updating Your Account

Changing Your Access Number

Removing TotalAccess



How to Install TotalAccess Software: 
Windows 95
To set up an Internet account with EarthLink Network, you will need EarthLink
Network’s CD-ROM. To begin the installation, insert EarthLink Network’s 
CD-ROM into the CD-ROM drive, and follow the instructions printed on the
inside of EarthLink Network’s CD-ROM package. TotalAccess is designed 
to be installed easily with the help of on-screen instructions. The information
below is intended to complement this on-screen information.

You will need at least 8MB of RAM to use TotalAccess. To find out how much RAM
is in your computer, click on My Computer, open the Control Panels folder, and
then open System. Check your computer manual for information about adding more
RAM if you need it.

You will need to have your Windows 95 installation software on hand while you are
installing TotalAccess because your computer is likely to require some files from these
disks. Your computer will tell you exactly which Windows 95 disks it needs.



The Online Registration Process: Windows 95
You will be given a choice between opening a new account and retrieving 
an existing account. 

Choose to retrieve an existing account if you have spoken to an EarthLink Network
sales representative and received a username and password from EarthLink. 

Choose to set up a new account only if you have NOT received a username and
password from EarthLink.

At a certain point in the registration process you will be asked to create a “username.”
This name will identify you within the EarthLink Network. It will also become the
first part of your email address, which will be username@earthlink.net
Many people create their usernames by combining their first initial and their last name.
You may choose to follow this convention, but you don’t have to. Your username can be
anything you want it to be, but only letters and numbers can be used (although the
first character cannot be a number), all of the characters must be lowercase, and
it can only be 12 characters or less in length.

When choosing a password, try to pick something difficult to guess. (Don’t use your
name or the word “password.”) The best passwords are 6-8 characters long and include
both letters and numbers. Once you have selected a password, write it down
and keep it in a safe place (in case you forget it).



Completing Registration: Windows 95
To complete registration, simply follow the procedures given in the Instructions
window. Windows 95 will work with EarthLink Network TotalAccess software to
identify and configure your modem automatically.

You will then be connected to the EarthLink Network registration server via an 800
number and given an opportunity to choose the phone number of a POP to dial into on
a permanent basis. (Check with your phone company to confirm that this number
will be a local call.) Once you have done this, registration has been completed.



Using Your Account: Windows 95
If you have just retrieved an existing account, chances are you can log back on and
immediately use this account.  But if you have just set up a new account, it may take a
little while for your registration to be processed. You can try sooner, but it may take
60-90 minutes to access a new account.

When you are ready to connect to the Internet through your EarthLink account, click
the My Computer icon, open the Dial-Up Networking folder which appears, click on
the EarthLink Network icon, confirm that your username and password are correct,
and then click the Connect button. When you are finished with your online session,
click the Disconnect button.



Troubleshooting: Windows 95
Occasionally, difficulties arise during the registration process. 
If you encounter a problem, an error message may appear on 
the screen. Here are some of the more common error messages.
Click a message to access its possible solutions:

• Can’t initialize your modem

• The computer is not receiving a response

from the network

• The modem is being used by another dial-up

networking connection or another program

• Registration locks up while your computer is

authorizing connection to the 800 number

• The username you have chosen is already in

use by another EarthLink Network customer

NOTE: If these suggestions do not solve your problem, feel free to contact 
EarthLink Network Technical Support at any time. 
See How to Contact EarthLink for further information.

Jump to
Updating

Your
Account



• Can’t initialize your modem

Make sure that your modem is connected. If you still experience problems, try 
resetting your modem by turning it off briefly and then back on. If you are using 
an internal modem, reboot your computer.

Return to Troubleshooting: Windows 95



• The computer is not receiving a response

from the network

Make sure that your modem is connected. If you still experience problems, try 
resetting your modem by turning it off briefly and then back on. If you are using 
an internal modem, reboot your computer.

Return to Troubleshooting: Windows 95



• The modem is being used by another dial-up

networking connection or another program

Make sure your modem is plugged into the correct COM port. To change the COM
port selection, click the My Computer icon, open Control Panels, open Modems,
open Select Modem, open Properties, and then choose Port. Close any other 
programs, such as fax software, which may be using the modem’s COM port.

Return to Troubleshooting: Windows 95



• Registration locks up while your computer is

authorizing connection to the 800 number

Lower your modem’s speed rating (the “baud rate”) to 2400 bps. To do this, open
Control Panels, then Modems, then Select Modem, then Properties, and then Port.
Set Maximum Speed at 2400. 

Remember to increase the baud rate to the previous value after registration!

Return to Troubleshooting: Windows 95



• The username you have chosen is already in

use by another EarthLink Network customer

If you receive this message, select another username. But if you receive this error 
message after you have already tried to register once, stop. You may in fact have 
registered successfully the first time. Sometimes customers complete their account
without realizing it; if you register again, you’ll end up with two accounts! If you 
do set up two accounts accidentally, contact our billing department at
accounts@earthlink.net and they will correct the problem.

If you think you may have successfully registered already, click the Cancel button to
stop registration, and wait an additional 15 minutes to give the registration server time
to sign you up. Then try to connect to EarthLink through your local POP.

If this doesn’t work, open Registration and Utilities. When asked if you would like
to start a new account, say “No.” Then try to retrieve your account by typing in the
username and password you initially used to register your account. If you can retrieve
your account in this manner, you have been registered successfully.

Return to Troubleshooting: Windows 95



Updating Your Account: Windows 95
You may update your account information at any time, without any
charge. Just connect to the EarthLink Network registration server
by opening the Programs folder in the Start-Up menu, then open
the TotalAccess folder, and open Registration and Utilities. Go to

the Account tab, and click on the Update button. You will be connected through our
800 number. A series of screens will allow you to update your name, address, phone,
fax, credit card information, and the setup of your modem. You can also use the
Update button to change your login and email passwords. If you prefer, you can
change your passwords by calling or emailing us. See How to Contact EarthLink
for more information.



Changing Your Access Number: Windows 95
To see if any new access numbers have been added, go to:
http://www.earthlink.net/priv/dialuplist.html

If you need to change the phone number you use to connect to EarthLink Network, go
to Registration and Utilities, select Dial-Up, and then Number.  You will find a full
list of phone numbers to choose from.  

http://www.earthlink.net/priv/dialuplist.html


Removing TotalAccess: Windows 95
If for any reason you wish to remove TotalAccess from your 
computer, follow these steps: Throw away the EarthLink folder 
on your C: drive. Then, to remove the TotalAccess folder from the
Start menu, right-click in a blank area of the task bar, and select

Properties. Select the Start Menu Programs tab, and click the Remove button.
Highlight the TotalAccess folder, and click Remove.

Jump to Setting Up Microsoft Internet Explorer 3.0

Jump to Setting Up Netscape Navigator 3.0



TotalAccess Registration 
for Windows 3.1

Click the topics below for further information:

How to Install TotalAccess Software

The Online Registration Process

Completing Registration

Using Your Account

Troubleshooting

Updating Your Account

Changing Your Access Number

Removing TotalAccess



How to Install TotalAccess Software:
Windows 3.1
To set up an Internet account with EarthLink Network, you will need EarthLink
Network’s CD-ROM. To begin the installation, insert EarthLink Network’s 
CD-ROM into the CD-ROM drive, and follow the instructions printed on the
inside of EarthLink Network’s CD-ROM package. TotalAccess is designed to 
be installed easily with the help of on-screen instructions. The information
below is intended to complement this on-screen information.

You will need at least 8MB of RAM to use TotalAccess. To find out how much RAM
is in your computer, go to the MS-DOS prompt, type “mem”, and then press Return,
which will take you to the screen display for this information. Check your computer
manual for information about adding more RAM if you need it.



The Online Registration Process: Windows 3.1
You will be given a choice between opening a new account and retrieving 
an existing account. 

Choose to retrieve an existing account if you have spoken to an EarthLink Network
sales representative and received a username and password from EarthLink. 

Choose to set up a new account only if you have NOT received a username and
password from EarthLink.

At a certain point in the registration process you will be asked to create a “username.”
This name will identify you within the EarthLink Network. It will also become the first
part of your email address, which will be username@earthlink.net
Many people create their usernames by combining their first initial and their last name.
You may choose to follow this convention, but you don’t have to. Your username can be
anything you want it to be, but only letters and numbers can be used (although the
first character cannot be a number), all of the characters must be lowercase, and
it can only be 12 characters or less in length.

When choosing a password, try to pick something difficult to guess. (Don’t use your
name or the word “password.”) The best passwords are 6-8 characters long and include
both letters and numbers. Once you have selected a password, write it down
and keep it in a safe place (in case you forget it).



Completing Registration: Windows 3.1
To complete registration, simply follow the procedures given in the Instructions
window. During installation, you will be asked to provide some information
about your modem. Using the pull-down menus that appear at this point, select
your modem’s name and model number. If your modem is not listed, choose the
Default Modem Setting.

Next, select the COM port to which your modem is connected. (If you are unsure of
the correct COM port, refer to your computer manual for assistance.) Select a modem
speed by picking the setting that is one step above your modem’s rated speed. For
example, if you have a 14400 bps modem, select 19200; if you have a 28800 bps
modem, select 38400.

You will then be connected to the EarthLink Network registration server via an 800
number and given an opportunity to choose the phone number of a POP to dial into on
a permanent basis. (Check with your phone company to confirm that this number
will be a local call.) Once you have done this, registration has been completed.



Using Your Account: Windows 3.1
If you have just retrieved an existing account, chances are you can log back on and
immediately use this account.  But if you have just set up a new account, it may take a
little while for your registration to be processed. You can try sooner, but it may take
60-90 minutes to access a new account.

When you are ready to connect to the Internet through your EarthLink account, open
the Internet Dialer by clicking on its icon in your TotalAccess folder. Click Connect
and use the pull-down menu to select your username. Your modem will then establish
a connection to the Internet through EarthLink Network. When you are finished with
your online session, click Disconnect.



Troubleshooting: Windows 3.1
Occasionally, difficulties arise during the registration process. 
If you encounter a problem, an error message may appear on 
the screen. Here are some of the more common error messages.
Click a message to access its possible solutions:

• Can’t initialize your modem

• Another application is using your modem or your

modem settings are incorrect

• Registration locks up while your computer is

authorizing connection to the 800 number

• The username you have chosen is already in

use by another EarthLink Network customer

NOTE: If these suggestions do not solve your problem, feel free to contact 
EarthLink Network Technical Support at any time. 
See How to Contact EarthLink for further information.

Jump to Updating Your Account



• Can’t initialize your modem

Make sure that your modem is connected. Also, make sure your modem is properly
named in Modem Information. If you still experience problems, try resetting your
modem by turning it off briefly and then back on. If you are using an internal modem,
reboot your computer.

Return to Troubleshooting: Windows 3.1



• Another application is using your modem or your

modem settings are incorrect

Make sure that your modem is plugged into the correct COM port. You will 
also receive this message if you are trying to run fax software at the same time. 
Turn off all fax software. 

Return to Troubleshooting: Windows 3.1



• Registration locks up while your computer is

authorizing connection to the 800 number

Lower your modem’s speed rating (the “baud rate”) to 2400 bps in the Modem
Information screen, and try again. 

Remember to increase the baud rate to the previous value after registration!

Return to Troubleshooting: Windows 3.1



• The username you have chosen is already in

use by another EarthLink Network customer

If you receive this message, select another username. But if you receive this error 
message after you have already tried to register once, stop. You may in fact have 
registered successfully the first time. Sometimes customers complete their account
without realizing it; if you register again, you’ll end up with two accounts! If you 
do set up two accounts accidentally, contact our billing department at
accounts@earthlink.net and they will correct the problem.

If you think you may have successfully registered already, click the Cancel button to
stop registration, and wait an additional 15 minutes to give the registration server time
to sign you up. Then try to connect again to EarthLink through your local POP.

If this doesn’t work, open Registration and Utilities. When asked if you would like
to start a new account, say “No.” Then try to retrieve your account by typing in the
username and password you initially used to register your account. If you can retrieve
your account in this manner, you have been registered successfully.

Return to Troubleshooting: Windows 3.1



Updating Your Account: Windows 3.1
You may update your account information at any time, without 
any charge. Just connect to EarthLink Network by clicking on
Registration and Utilities in the TotalAccess folder. Click on
Account, and then Update. You will be connected through our 

800 number. A series of screens will allow you to update your name, address, phone,
fax, credit card information, and the setup of your modem. You can also use the
Update button to change your login and email passwords. If you prefer, you can
change your passwords by calling or emailing us. See How to Contact EarthLink
for more information.



Changing Your Access Number: Windows 3.1
To see if any new access numbers have been added, check the following URL:
http://www.earthlink.net/priv/dialuplist.html

If you need to change the phone number you use to connect to EarthLink Network,
go to Registration and Utilities, select Dial-Up, and then Number.  You will find a
full list of phone numbers to choose from. 

http://www.earthlink.net/priv/dialuplist.html


Removing TotalAccess: Windows 3.1
If for any reason you wish to remove TotalAccess from your 
computer, follow these steps: Open Registration and Utilities,
click on Utilities, and then select Uninstall.

Jump to Setting Up Netscape Navigator 3.0



TotalAccess Registration 
for Macintosh

Click the topics below for further information:

How to Install TotalAccess Software

The Online Registration Process

Completing Registration

Using Your Account

Troubleshooting

Updating Your Account

Changing Your Access Number

Removing TotalAccess



How to Install TotalAccess Software: Macintosh
To set up an Internet account with EarthLink Network, you will need EarthLink
Network’s CD-ROM. To begin the installation, insert EarthLink Network’s 
CD-ROM into the CD-ROM drive, and follow the instructions printed on the
inside of EarthLink Network’s CD-ROM package. TotalAccess is designed to 
be installed easily with the help of on-screen instructions. The information
below is intended to complement this on-screen information.

You will need at least 8MB of RAM to use TotalAccess. To find out how much RAM
is in your computer, go to the Apple menu and select About This Macintosh. Check
your computer manual for information about adding more RAM if you need it.



The Online Registration Process: Macintosh
You will be given a choice between opening a new account and retrieving 
an existing account. 

Choose to retrieve an existing account if you have spoken to an EarthLink Network
sales representative and received a username and password from EarthLink. 

Choose to set up a new account only if you have NOT received a username and
password from EarthLink.

At a certain point in the registration process you will be asked to create a “username.”
This name will identify you within the EarthLink Network. It will also become the first
part of your email address, which will be username@earthlink.net 
Many people create their usernames by combining their first initial and their last name.
You may choose to follow this convention, but you don’t have to. Your username can be
anything you want it to be, but only letters and numbers can be used (although the
first character cannot be a number), all of the characters must be lowercase, and
it can only be 12 characters or less in length.

When choosing a password, try to pick something difficult to guess. (Don’t use your
name or the word “password.”) The best passwords are 6-8 characters long and include
both letters and numbers. Once you have selected a password, write it down
and keep it in a safe place (in case you forget it).



Completing Registration: Macintosh
To complete registration, simply follow the procedures given in the Instructions
window. During installation, you will be asked to provide some information
about your modem. Using the pull-down menus that appear at this point, select
your modem’s name and model number. If your modem is not listed, choose the
Default Modem Setting.

Next, select the computer port to which your modem is connected. (Most likely, this
will be the Modem Port.) Finally, select a modem speed by picking the setting that is
one step above your modem’s rated speed. For example, if you have a 14400 bps
modem, select 19200; if you have a 28800 bps modem, select 38400.

You will then be connected to the EarthLink Network registration server via an 800
number and given an opportunity to choose the phone number of a POP to dial into on
a permanent basis. (Check with your phone company to confirm that this number
will be a local call.) Once you have done this, registration has been completed.



Using Your Account: Macintosh
If you have just retrieved an existing account, chances are you can log back on and
immediately use this account.  But if you have just set up a new account, it may take a
little while for your registration to be processed. You can try sooner, but it may take
60-90 minutes to access a new account.

When you are ready to connect to the Internet through your EarthLink account, dou-
ble-click the Internet Dialer icon, make sure your username appears, and click the
Connect button. When you are finished with your online session, click Disconnect.



Troubleshooting: Macintosh
Occasionally, difficulties arise during the registration process. 
If you encounter a problem, an error message may appear on 
the screen. Here are some of the more common error messages.
Click a message to access its possible solutions:

• Can’t find your modem

• Can’t initialize your modem

• Registration hangs up while your computer is

authorizing connection to the 800 number

• The username you have chosen is already in

use by another EarthLink Network customer

• After registration, the installation stalls

while installing the Internet tools

• Not all of the Internet tools, such as Internet

Dialer or Netscape Navigator, are installed

• Internet Dialer is not installed

NOTE: If these suggestions do not help, go to How to Contact EarthLink
for information on contacting EarthLink Technical Support.
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• Can’t find your modem

Make sure your modem is turned on. Also, make sure that your modem is plugged into
one of your computer ports and that this connection is noted correctly in the Port
menu of the Modem Setup screen in Registration and Utilities. If you still experi-
ence problems, try resetting your modem by turning it off briefly and then back on.

Return to Troubleshooting: Macintosh



• Can’t initialize your modem

This error message usually appears while dialing the registration server. Make sure you
have specified the right name, model, and speed for your modem in Modem Setup.

If you are using Macintosh Operating System 7.5 or higher, try connecting to
EarthLink using System 7.5 extensions only. Go to your Apple menu and select
Control Panels. Choose the Extensions Manager, and then Sets. Select System
7.5, and then close the Extensions Manager. Restart your computer and open
Registration and Utilities. You will be asked if you would like to start a new
account. Say “No” if you have already been given a username and password.
Continue with the Retrieve Account screen.

Return to Troubleshooting: Macintosh



• Registration hangs up while your computer is

authorizing connection to the 800 number

Lower your modem’s speed rating (the “baud rate”) to 9600 or 2400 bps in the
Modem Setup screen, and try again. 

Remember to increase the baud rate to the previous value after registration.

Return to Troubleshooting: Macintosh



• The username you have chosen is already in use 

by another EarthLink Network customer

If you receive this message, select another username. But if you receive this
error message after you have already tried to register once, stop. You may in 
fact have registered successfully the first time. Sometimes customers complete
their account without realizing it; if you register again, you’ll end up with two
accounts! If you do set up two accounts accidentally, contact our billing depart-
ment at accounts@earthlink.net and they will correct the problem.

If you think you may have successfully registered already, click the Cancel button to
stop registration, and wait an additional 15 minutes to give the registration server time
to sign you up. Then try to connect again to EarthLink through your local POP.

If this doesn’t work, close Internet Dialer and open Registration and Utilities. 
When asked if you would like to start a new account, say “No.” Then try to retrieve
your account by typing in the username and password you initially used to register
your account. If you can retrieve your account in this manner, you have been 
registered successfully.

Return to Troubleshooting: Macintosh



• After registration, the installation stalls 

while installing the Internet tools

Go to the Finder icon and select TotalAccess Registration to restart installation.

Return to Troubleshooting: Macintosh



• Not all of the Internet tools, such as Internet

Dialer or Netscape Navigator, are installed

Check About This Macintosh in the Apple menu to see how much RAM is free in
your computer. If less than 4MB of RAM is available, go to Control Panels, select
Memory, turn on Virtual Memory, and then restart your computer. Then try to
retrieve your account again.

Return to Troubleshooting: Macintosh



• Internet Dialer is not installed

If you have successfully registered your account, you should find EarthLink’s Internet
Dialer icon in your TotalAccess folder. If the Dialer is not there, open Preferences in
your System Folder. Look in the TotalAccess Preferences folder for two files: the
Internet Tools Vol. 1 Installer and the Internet Tools Vol. 2 Installer. Throw these
two files away. Then retrieve your account again. After this is done, restart your com-
puter, and then go back to Registration and Utilities.

Return to Troubleshooting: Macintosh



Updating Your Account: Macintosh
You may update your account information at any time, without
any charge. Just connect to EarthLink Network by clicking on
Registration and Utilities in the TotalAccess folder. Click on
Account, and then Update. You will be connected through our

800 number. A series of screens will allow you to update your name, address, phone,
fax, credit card information, and the setup of your modem. You can also use the
Update button to change your login and email passwords. If you prefer, you can
change your passwords by calling or emailing us. See How to Contact EarthLink
for more information.



Changing Your Access Number: Macintosh
To see if any new access numbers have been added, go to:
http://www.earthlink.net/priv/dialuplist.html

If you need to change the phone number you use to connect to EarthLink Network, go
to Registration and Utilities, select Phone, and then Change Dialup.  You will find a
full list of phone numbers to choose from.  

http://www.earthlink.net/priv/dialuplist.html


Removing TotalAccess: Macintosh
If for any reason you wish to remove TotalAccess from your
computer, follow these steps: Delete the TotalAccess folder on
your hard drive. Then go into your System Folder and delete
MacTCP DNR.

While still in the System Folder, open the Preferences folder. Delete any of 
the following files that you find: the TotalAccess folder, MacTCP Prep,
MacTCP Prep Backup, Netscape Navigator Preferences, PPP Preferences,
and TCP/IP Preferences.  

While still in the System Folder, open the Control Panels folder and remove* any of
the following files that you find: MacTCP and Config FreePPP. Next, while still in
the System Folder, open the Extensions folder and remove* any of the following
files that you find: FreePPP and TotalAccess PPP.  

*NOTE: You may need some of these files for other future networking processes, so
we recommend that you do not delete these files. Instead, place the files in 
a storage folder kept somewhere outside of your System Folder.
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Setting Up 
Netscape Navigator 3.0

If Netscape Navigator was installed on your computer during the TotalAccess
registration process, then this section pertains to you. Netscape Navigator is a Web
browser, the essential tool for gaining access to multimedia Internet sites around the
world. Netscape Navigator also incorporates an email program capable of sending and
receiving electronic mail. (It might seem obvious, but please note that email programs
can only accomplish these functions while you are connected to the Internet!)

Click any of the topics below to access further information about Netscape Navigator:

Configuring Netscape Navigator to
Open to EarthLink’s Homepage
Where else would you want to start
each journey onto the Net? It’s like 
waking up to the sound of birds
singing and fresh coffee brewing….



Email and Newsgroup Settings
These need to be correct in order to read and respond to 
email and newsgroups.

Netscape Mail
Netscape Navigator: it slices, it dices, it even sends and receives email!

Signatures and Attached Files
How to add your signature to email AND send a file along for the ride.

Address Book
“Don’t you dare lose Aunt Bee’s email address; keep it in your address book!”

Netscape News
Netscape Navigator: it slices, it dices, it even reads and responds to newsgroups.

Accessing Graphic and Sound Files
Even Netscape Navigator can use a helping hand to access 
unusual images or sounds.

The Cache Folder
Netscape Navigator’s cache folder is like your refrigerator; sometimes you 
need to clean out the gunk to close it properly….



Configuring Netscape Navigator to 
Open to EarthLink’s Homepage
If your copy of Netscape Navigator doesn’t open automatically to EarthLink
Network’s homepage, you may want to configure it to do so. Go to Netscape
Navigator’s Options menu. Choose General Preferences and select the 
Appearance tab. Under Browser Starts With, select Home Page Location,
and type in EarthLink’s URL: http://www.earthlink.net



Email and Newsgroup Settings
Netscape Navigator can also be used to send and receive email, and to read and respond
to newsgroups. The preference settings for these uses should have been established 
during TotalAccess installation. But if you need to add these preferences yourself,
choose Mail and News Preferences in the Options menu. Enter the following:

At the Servers tab:
Outgoing Mail (SMTP) Server: mail.earthlink.net
Incoming Mail (POP) Server: mail.earthlink.net
POP User ID: username 

(Be sure to replace “username” with your actual EarthLink username.)
News (NNTP) Server: news.earthlink.net

At the Identity tab:
Your Name: (Optional—this places your real name next to your email address.)
Your Email: username@earthlink.net

(Be sure to replace “username” with your actual EarthLink username.)



Netscape Mail
With these settings configured properly, it is easy to use Netscape Navigator to
receive and send email. Go to the Window menu and pull down to Netscape Mail.
Enter your password if necessary. Netscape Mail™ will check to see if you have
any mail. If there is mail for you, Netscape will place it in the Inbox folder, which
will appear in the list of folders on the left side of the browser window. Select
Inbox, and each individual Inbox message will be listed on the right side of the
browser. Click on a message you want to read, and it will appear in the large frame
in the bottom half of the browser window.

If you want to respond to a message, select Reply from the Message menu. 
(For new messages, select New Mail Message from the File menu.) The Message
Composition window will appear. Type in your response and click the Send Now
button. To print out a message you are reading, select Print from the File menu. 
To attach a file to your message, select Attach from the File menu.

You can even mail someone a Web page using Netscape Mail. Just go to the Web page
with your browser, and then choose Mail Document from Netscape Navigator’s File
menu. Fill out the Message Composition window that appears, and click Send Now.
The Web page is then on its way!



Signatures and Attached Files
You can also configure Netscape Navigator to add your signature file to the
Netscape Navigator mail you send. Create and save your signature with a text
editor, and then return to Netscape Navigator. Go to Mail and News Preferences
within the Options menu. Find Signature File at the Identity tab. Check File,
then using the Browse button, select the signature file you have prepared.
Netscape Navigator will automatically add this file to your correspondence.



Address Book
To use Netscape Mail’s Address Book, go to the Window menu, and open up
Address Book. Go to the Item menu and open Add User. Fill out the address
form that appears, and click OK. Then, next time you want to send email to this
individual, open Address Book. The address will be stored there. Click twice on
the person’s name, and a properly addressed Message Composition window will
appear for you to use.



Netscape News
You can also use Netscape Navigator to participate in newsgroups. (See the Usenet
section of this guide for information on newsgroups.) To access a specific newsgroup
in Netscape Navigator, select Netscape News from the Window pull-down menu or
enter the name of the newsgroup you want to read in the Netsite: blank. For example,
if you wish to view the earthlink.announcements newsgroup, you would 
enter news:earthlink.announcements

To find a list of the newsgroups specifically carried on EarthLink’s server, click
Newsgroups on our homepage.  Some basic instructions on using Navigator are avail-
able in The World Wide Web section of this guide.  For further information about
Netscape Navigator, email, and newsgroups, look in Netscape’s online manual which
can be reached at http://home.netscape.com/eng/mozilla/3.0/handbook/

http://home.netscape.com/eng/mozilla/3.0/handbook/
http://www.earthlink.net/nethelp/news.html


Accessing Graphic and Sound Files
You may want to access image or sound files composed in formats which are not 
supported by Netscape Navigator itself. You can find several graphic viewer and sound
player helper applications at the following sites:

Macintosh users: http://wwwhost.ots.utexas.edu/mac/main.html

PC users: http://www.tucows.com or http://www.stroud.com

http://wwwhost.ots.utexas.edu/mac/main.html
http://www.stroud.com
http://www.tucows.com


The Cache Folder
Netscape Navigator uses a cache folder to speed up the performance of your browser.
Files from recently viewed Web pages are stored in this folder on your hard drive, so
that when you visit these sites again, Netscape Navigator can load them from your
computer rather than from the remote Internet site.

You may wish to clear the cache occasionally, especially if Netscape Navigator takes a
long time to close. To clear the cache, go to Network Preferences in the Options
menu, and then click on the Cache tab. Windows users should clear both the disk
cache and the memory cache. Macintosh users should clear the disk cache.



Setting Up Microsoft 
Internet Explorer 3.0

If Microsoft Internet Explorer 3.0 was installed on your computer during the
TotalAccess registration process, then this section pertains to you. 

Internet Explorer is a Web browser, the essential tool for gaining access to multimedia
Internet sites around the world.  Included with Internet Explorer is Microsoft Internet
Mail™, an email program capable of sending and receiving electronic mail. (It might
seem obvious, but please note that email programs can only accomplish these func-
tions while you are connected to the Internet!)

Click any of the topics below to access further information about Internet Explorer:

Configuring Internet Explorer to
Open to EarthLink’s Homepage
Where else would you want to start
each journey onto the Net? It’s like 
waking up to the sound of birds
singing and fresh coffee brewing….



Email and Newsgroup Settings
These need to be correct in order to read and 
respond to email and newsgroups.

Microsoft Internet Mail
Internet Explorer: it slices, it dices, it even sends and receives email!

Signatures and Attached Files
How to add your signature to email AND send a file along for the ride.

Address Book
“Don’t you dare lose Aunt Bee’s email address; keep it in your address book!”

Microsoft Internet News
Internet Explorer: it slices, it dices, it even reads and responds to newsgroups.

Accessing Graphic and Sound Files
Even Internet Explorer can use a helping hand to access unusual images or sounds.

Temporary Internet Files
Internet Explorer’s cache folder is like your refrigerator; sometimes you need
to clean out the gunk to close it properly….



Configuring Microsoft Internet Explorer to 
Open to EarthLink’s Homepage
If your copy of Internet Explorer doesn’t open automatically to EarthLink Network’s
homepage, you may want to configure it to do so.  From Internet Explorer’s View
menu, choose Options, and select the Navigation tab.  For Page, select Start Page,
and for Address, type in EarthLink’s URL: http://www.earthlink.net



Email and Newsgroup Settings
Microsoft Internet Mail and News, installed with Internet Explorer, can be used to
send and receive email, and to read and respond to newsgroups.  The preference 
settings for these uses should have been established during TotalAccess installation.
But if you need to add these preferences yourself, first open Internet Mail, then 
choose Options from the Mail menu.  Enter the following:

At the Server tab:
Name: (Optional—this places your real name next to your email address.)
Email address: username@earthlink.net (Be sure to replace 

“username” with your actual EarthLink username.)
Outgoing Mail (SMTP): mail.earthlink.net
Incoming Mail (POP3): mail.earthlink.net
POP3 Account: username (Be sure to replace “username”

with your actual EarthLink username.)
Password: (Your email password—leave blank to force the program 

to prompt you for your password when you check mail.)



Now open Internet News, and choose Options from the News menu.

Enter the following:

At the Server tab:
Name: (Optional—this places your real name next to your email address.)
Email address: username@earthlink.net

(Be sure to replace “username” with your actual EarthLink username.)

If news.earthlink.net does not appear in the list of news servers, click on the
Add button, and enter the following:

News Server Name: news.earthlink.net

Click on the Set as Default button below, and then click OK.



Microsoft Internet Mail
With these settings configured properly, it is easy to use Microsoft’s Internet Mail™
to receive and send email.  To check mail, choose Send and Receive from the Mail
menu.  Enter your password if necessary.  Internet Mail will check to see if you have
any mail.  If there is mail for you, Internet Mail will place it in the Inbox, which will
appear in the drop-down listbox at the top of the Internet Mail window.  Select Inbox,
and each individual Inbox message will be listed in the top frame of the program 
window.  Click on a message you want to read, and it will appear in the large frame 
in the bottom half of the program window.

If you want to respond to a message, select Reply to Author or Reply to All from the
Mail menu.  (For new messages, select New Message from the Mail menu.) The
Message Composition window will appear.  Type in your response and select Send
Message from the File menu.  To print out a message you are reading, select Print
from the File menu.  To attach a file to your message, select File Attachment from
the Insert menu.

You can even mail someone a shortcut to a Web page using Internet Mail.  Just go to
the Web page with your browser, and then choose Send to Mail Recipient from
Internet Explorer’s File menu.  Fill out the Message Composition window that
appears, and select Send Message from the File menu.  A shortcut to the Web
page is then on its way!



Signatures and Attached Files
You can also configure Internet Mail to add a signature to the mail you send.  From
the Mail menu, choose Options, and select the Signature tab.  Click on Text, and
type your signature in the text box.  Alternatively, if you already have a signature 
created and saved to a file, you can click on File and enter the path to your signature
file (or click on the Browse button to find the file).  Internet Mail will automatically
add this file to your correspondence.



Address Book
To use Internet Mail’s Address Book, select Address Book from the File menu.
Choose New Contact from the File menu.  Fill out the address form that appears,
and click OK.  Then, the next time you want to send email to this individual, open a
new message window, and click on the card icon next to the To field.  This will bring
up a Select Recipient window in which you can select entries from your address
book. Double-click on the person’s name and then click OK to add this address to 
the recipient list of the message.



Microsoft Internet News
You can use Microsoft Internet News to participate in newsgroups.  (For more infor-
mation on newsgroups, see the Usenet section of this electronic guide.)  To search for
newsgroups in Internet News, first click on the Mail icon on the browser toolbar, then
choose Read News.  Next, click the Newsgroups icon in the toolbar, and enter search
words separated by spaces.  A list of newsgroups with names containing the words
entered will appear below, and you can select to go to or subscribe to ones that interest
you.  For example, if you wish to search for EarthLink newsgroups, you can enter
earthlink, and all EarthLink newsgroups will be displayed.

To find a list of the newsgroups specifically carried on EarthLink’s server, click
Newsgroups on our homepage.

Some basic instructions on using Microsoft Internet Explorer are available in 
The World Wide Web section of this electronic guide.  For further information 
about Microsoft Internet Explorer, Internet Mail, and Internet News, choose 
Help Topics from any of the Microsoft Help menus.



Accessing Graphic and Sound Files
You may want to access image or sound files composed in formats which are not sup-
ported by Microsoft Internet Explorer itself.  You can find several graphic viewer and
sound player helper applications at the following sites: http://www.tucows.com
or  http://www.stroud.com

http://www.stroud.com
http://www.tucows.com


Temporary Internet Files
Microsoft Internet Explorer uses a cache folder to speed up the performance of your
browser.  Files from recently viewed Web pages are stored in this folder on your hard
drive, so that when you visit these sites again, Microsoft Internet Explorer can load
them from your computer rather than from the remote Internet site.  

You may wish to empty the Temporary Internet Files folder occasionally, especially
if Microsoft Internet Explorer takes a long time to close.  To empty the folder, choose
Options from the View menu, and select the Advanced tab.  Click the Settings button
and then click Empty Folder.  You may also wish to decrease the size of the folder
used for temporary Internet files to conserve disk space.



Setting Up Eudora Light
Eudora Light™ is a popular, easy-to-use email program that you may want to try.
Plus, you can download it for free! Eudora Light checks for new email and 
downloads it, enabling you to read the email and answer it. (It might seem obvious,
but please note that email programs can only accomplish these functions while
you are connected to the Internet!) 

Click one of the topics below to access further information about Eudora Light:

How to Download Eudora Light from EarthLink
Now being served at your local EarthLink Web site: get it while it’s hot!

Email Settings
“Get these right, or you won’t get any mail.”

Address List
Now being served at your local EarthLink Web site.

Signatures and Attached Files
How to add your signature to email AND send a file along for the ride.

How to Access Eudora’s Online Manual
Need help? Let your fingers do the walking to this Web site.



How to Download Eudora Light from EarthLink
Eudora Light is Qualcomm’s freeware version of this popular email software. The
fully supported commercial version of Eudora is available directly from Qualcomm 
at http://www.qualcomm.com

Eudora Light can be downloaded from EarthLink’s homepage: depending on your
operating system, click either PC Software or Mac Software. Next, click the Email
link, and then Eudora. The program will then download to your computer. 

http://www.qualcomm.com
http://www.earthlink.net/nethelp/win_apps/
http://www.earthlink.net/nethelp/mac_apps/


Email Settings
Eudora is easy to set up. Go to the Special menu and choose Settings. 
Then go to the Getting Started menu, and fill in the following:

POP Account: username@earthlink.net
(Be sure to replace “username” with your own EarthLink username.)

To add or change the name that appears next to the return address of email 
messages you send, go to the Special menu, and choose Settings. Then 
go to the Getting Started and Hosts menus, enter the desired name in the 
Real Name line, and hit Return.



Address List
To save an email address in Eudora’s address list, highlight the address as it appears in
a piece of email, and choose Add As Recipient from the Special menu. That address
will now appear in the various submenus in the Message menu, where you can easily
retrieve it. You can also create “nicknames” for your email addresses; you’ll find the
Nicknames command in the Window menu.



Signatures and Attached Files
To create a signature file, select Signature from the Window menu. Before
sending your message, check the Signature icon (the scripted letters “JH”) in
the bar above your email message. Once checked, your signature will be placed
at the end of your message.

To attach a file to an email message, choose Attach Document from the Message
menu, then locate and select the file you wish to attach. When the message is sent,
the attached file will accompany it.



How to Access Eudora’s Online Manual
A complete online manual for Eudora Light can be found at Qualcomm’s Web site:
http://www.qualcomm.com/quest/light.html

http://www.qualcomm.com/quest/light.html


How to Contact EarthLink

For Technical
Support Questions:
If you are connected to the Web,
you can have your questions
answered quickly by looking
through the various online
Customer Assistance and
Technical Support resources avail-
able from EarthLink’s homepage.

You can also use email to contact Technical Support. Send your questions to 
support@earthlink.net

You can call us at (800) 395-8410. This number will allow you to connect to
EarthLink’s Fax-on-Demand system, or to speak to a Technical Support advisor.

Technical Support is available 24 hours a day, 7 days a week.

In over your head? Customer Service 
is ready to lend a helpful hand.



For Web Support Questions:
Send email to webmaster@earthlink.net 

For ISDN-Related Support Questions:
Send email to isdnsupport@earthlink.net

To Set Up a New Account, or 
to Add Services to an Existing Account:
Send email to sales@earthlink.net or call (800) 395-8425

For Questions About Your 
Bill or Your Account:
Send email to accounts@earthlink.net

For Customer Service Issues:
Send email to service@earthlink.net



For Questions About EarthLink’s 
Special Agent Referral Program:
Send email to referrals@earthlink.net

For Comments and Suggestions 
About Our Web Site:
Send email to elnweb@earthlink.net

For Comments or Questions Directed 
Toward EarthLink Management:
Send email to admin@earthlink.net

EarthLink Network, Inc.
3100 New York Drive
Pasadena, CA 91107

Main Office: (800) 876-3151
Main Office Hours: 9am to 6pm PST, Monday-Friday



Additional EarthLink
Programs and Services

Free Customer Web Space
Create your own homepage with your free customer Web space!

Bonus Referrals
Refer a friend and get free Internet Access.

Additional Emailboxes
How to get additional emailboxes and how much.

ISDN Services
Upgrade your connection for faster Internet access at our one-stop shop!

Frame Relay Services
A T1 line at your fingertips for the extra bandwidth you need.

Business Web Site Services
Set up your business Web site and get more bang out of your buck!

Customized TotalAccess Program
Bundle with TotalAccess and see your dollars grow!



Free Customer Web Space 
As part of your EarthLink Network service, you receive 2MB of free 
Web space for your own homepage.  To sign up for your reserved space,
and to get information about writing and uploading your homepage, go to
http://www.earthlink.net/priv/signup.html

http://www.earthlink.net/priv/signup.html


Bonus Referrals Program
At EarthLink, we still believe the greatest compliment from a customer is a referral.
Many of our new customers come from customers like you.

EarthLink customers who want to spread the word about their Internet service can get
a free month of unlimited usage by participating in our Referral Program.

For each person you refer, we’ll credit $19.95 towards your account.  Just have friends
mention your name and username upon signup.  

To further express our gratitude, we’ve introduced our Special Agent Referral
Program. Multiple referrals result in prizes!  For our current program (through the end
of ‘96), you can win free EarthLink shirts, jackets, and gift certificates—more  prizes
will be added in ‘97! 

For more information, visit http://www.earthlink.net/referral/
or write to referrals@earthlink.net

http://www.earthlink.net/referral/


Additional Emailboxes
You may decide that you would like more than one emailbox.  
Pricing information for additional mailboxes can be found at 
http://www.earthlink.net/company/getmailbox.html

or give us a call at (800) 395-8425. 

http://www.earthlink.net/company/getmailbox.html


ISDN Services
If you want a really speedy connection to the Internet, you may want to check out
EarthLink’s ISDN program.  An ISDN line can provide high-speed Internet access at
nearly five times the rate of a standard 28.8Kbps analog modem.

EarthLink’s one-stop ISDN shop provides everything you need for ISDN access—
at incredibly low prices.  Contact EarthLink Sales at (888) ELN-ISDN or at 
sales@earthlink.net



Frame Relay Services
Sometimes, ISDN isn’t enough.  Maybe you want to put an entire LAN on the
Internet, or maybe you just want lightning speed for yourself.  Whatever the case,
EarthLink can help you.  We’ll lease you a Fractional T1 line, with the option of
expanding to a full T1 (1.536MB) when you decide you need the extra bandwidth.
This is a national service, available at competitive rates. 

You can find more information at
http://www.earthlink.net/company/high_speed.html

or you can contact us at (800) 511-2044 or corpsales@earthlink.net

http://www.earthlink.net/company/high_speed.html


Business Web Site Services
EarthLink provides as much space as you need (on our multiple T3 Internet 
connection) to put your business on the Web.  Whether your site is 5MB 
or 100MB, you get access to daily hit logs, custom CGI script capabilities,
and the chance to register your own unique Domain Name (mycompany.com).  
In addition, you get up to 1,500MB in free traffic volume, email alias 
opportunities, access to secure servers, and professional support from 
EarthLink’s Business Services Support Team.

You can find more information (including pricing) at 
http://www.earthlink.net/company/webservices.html

or you can contact our Business Sales department at (800) 511-2044 
or corpsales@earthlink.net

http://www.earthlink.net/company/webservices.html


Customized TotalAccess Program
The Internet holds tremendous commercial potential.  That’s why EarthLink
Network employs an exciting tool to integrate your company with the Internet
via a customized CD-ROM. 

This is the way it works: your target audience receives the custom EarthLink Network
TotalAccess package, subscribes to the Internet through EarthLink, then logs on to the
Internet starting at your company’s homepage at the beginning of each session. 

Custom packages are quoted on a per-order basis.  Bounty programs are available.
Prices are subject to change without notice. 

You can find more information at http://www.earthlink.net/
company/webservices.html or you can contact our Business Sales 
department at (800) 511-2044 or corpsales@earthlink.net

http://www.earthlink.net/company/webservices.html
http://www.earthlink.net/company/webservices.html


alt. 
Name of the alternative set of news-
groups.  There are more alt. newsgroups
than any other set because Usenet was
set up so anyone could create an alt.
group.  The result has been thousands
of groups, many of them bizarre.

article
A message posted to a newsgroup.

biz.
Name of the business-related set of
newsgroups.

Glossary
This glossary provides some simple 
definitions for Internet terms used in 
this book. In many cases, only the 
definition applicable to the context of 
this book has been included. If you 
want more detailed definitions, consult 
a computer dictionary. Alan Freedman’s 
The Computer Glossary, published by 
AMACOM, is a good one.

“Class, who
knows the

definition of
‘spamming’?”



bookmark
A saved address of an Internet site
which can be quickly loaded so your
browser displays the site.

browser
Software for viewing Web 
pages.  Netscape Navigator and
Microsoft Internet Explorer are both
browsers.

cache
Temporary storage space.  Web pages
you access are stored in your browser’s
cache directory (on your hard drive).
So, when you return to a Web site
you’ve recently accessed, your browser
calls it up from the cache rather than
the original server.  This saves you
time, and it saves the server from being
unnecessarily overloaded.

comp.
Name of the computer-related set of
newsgroups.

dialer
The software used to dial your modem
and connect to an EarthLink POP.

discussion group
A group on Usenet devoted to a certain
subject.  Also called a newsgroup.

EarthLink
Your Internet Service Provider.

earthlink.net
The hostname of your email 
address.  Your email address is 
username@earthlink.net 

The hostname is the Internet address 
of EarthLink’s email servers, where
your email is stored until you dial into
a POP and pick it up.



electronic mail
The most popular use of the Internet.
Electronic mail, or email, allows any
user on the Internet to send a nearly
instantaneous electronic message to
anyone else on the Internet who has 
an email address.

email
Abbreviation for electronic mail.

emailbox
1) The place where your email is stored

on EarthLink’s email servers until
you log into an EarthLink POP and
retrieve it with your email program.

2) A directory within your email pro-
gram where you store email on your
computer once it is downloaded. 

Eudora Light
A popular email program that can be
downloaded from EarthLink’s site.

FAQ
Abbreviation for Frequently 
Asked Questions.

favorites
A saved address of an Internet site
which can be quickly loaded so the
Microsoft Internet Explorer browser
displays the site.  

flame
An abrasive email or newsgroup 
posting, usually containing abusive 
language.  Flames often result from
spamming. Flames are not pleasant to
receive, and this book advises against
sending them.



Frequently Asked Questions
FAQ for short.  A list of common 
questions and answers on a given 
subject, usually maintained by 
enthusiasts in a particular newsgroup.
It is always wise to check the FAQ
before asking what may be a common
question in a newsgroup.

homepage
The main page of a Web site.

host
A computer connected to the Internet
that stores and provides information 
of some sort.  Email is kept on a 
host.  So are Web pages.  A host is 
also called a server.

hostname
The name of a particular host, or 
server, computer on the Internet.

HTML
Abbreviation for HyperText 
Markup Language.

HTTP
Abbreviation for HyperText 
Transfer Protocol.

hyperlink
A link from one Web page to another
Web page (or other document).

HyperText Markup Language
HTML for short.  The language used to
create Web documents which specifies
how the page will appear when dis-
played by a Web browser. 

IE
Abbreviation for Microsoft 
Internet Explorer.



Internet
Net for short.

1) That thing we’re all excited about.

2) A computer network connecting tens
of thousands of smaller computer
networks all around the globe that
use the TCP/IP protocol.  Any com-
puter can communicate with any
other computer on this network. 

ISP
Abbreviation for Internet Service
Provider.  An ISP is a company that
provides access to the Internet, as well
as other types of services, such as orig-
inal content, gaming, and Web page
development.  An ISP owns or rents the
equipment required to have POPs on
the Internet.  Larger ISPs have their
own high-speed leased lines so that

they are less dependent on the tele-
phone companies and can provide bet-
ter customer service.  EarthLink
Network is an ISP.

LAN
Local Area Network.  A network of
interconnected computers, typically
being shared within a company.

lurk
To spend time watching a newsgroup
without posting anything.

MB
Abbreviation for megabyte.  It’s a 
measure of computer memory or hard
disk storage; a little more than a 
million bytes (actually 1,048,576
bytes).  You need 8MB of RAM to
install TotalAccess software.



Microsoft
The company that created, among
many products, Internet Explorer.

Microsoft Internet Explorer 
Microsoft’s browser software that
allows you to navigate through 
information on the Web.

misc.
Name of the miscellaneous set of
newsgroups.

modem
A device that allows your 
computer to communicate 
with another computer 
over a phone line.

Net
Abbreviation for Internet.

Netiquette
A set of rules the Internet community
has developed to allow people to use its
resources responsibly. 

Netscape
1) The company that created 

Netscape Navigator. 

2) Short for Netscape Navigator.

Netscape Navigator
Netscape’s browser software that
allows you to navigate through infor-
mation on the Web.

network
Two or more connected computers that
communicate with one another.



Newbie
Someone new to the Internet, or to
computers in general.

news
Abbreviation for Usenet news.

newsgroup
A group on Usenet devoted to the 
discussion of a certain subject.

online
The state you (or your computer) are in
when you are connected to the Internet.

onramp
An EarthLink Point of Presence, or
POP, that you dial into with your 
computer and your modem to connect
to the Internet.

OS
Abbreviation for Operating System.
An operating system is the program
that manages all the other programs—
called applications—in a computer.
Several well-known operating sys-
tems are Windows 95, Macintosh,
OS/2, and UNIX.

page
A document on the Web that is 
displayed by a Web browser.

Point of Presence
POP for short.  An EarthLink number
in your city you dial with your comput-
er and your modem to connect to the
Internet.  

POP
Abbreviation for Point of Presence.



post
An article sent to a newsgroup.

protocol
A standard computers use to communi-
cate with one another.

quote
When you reply to an email message
or Usenet article, you may quote the
original message or posting so that
people reading it know what you 
are responding to.  Usually, a “>”
character is placed before each line
of the original message.

RAM
An abbreviation for Random Access
Memory.  RAM is “built-in” readable
and writable data storage that comes
preinstalled in (or can be added to) a
computer.  Typical PCs and Macs come

with 8 or 16 megabtyes of RAM (and
are often expandable up to 64MB—
or more).  RAM is called “random
access” because data is deposited in
and retrieved from memory in 
a non-sequential fashion.

rec.
Name of the recreation-related set of
newsgroups.

sci.
Name of the science-related set of
newsgroups.

server
A computer connected to the Internet
which stores and provides information
of some sort. Your email is kept on a
server. So are Web pages.  A server is
also called a host.



signature
Information attached to the bottom 
of an email message or newsgroup
posting that gives contact information
about the sender.  Signatures can 
contain any information, including
your name, email address, postal
address, or a witty saying. 

site
A particular “place” on the Internet.  
A Web page is often called a Web site.
Also used to refer to a server connected
to the Internet.

smiley
A facial expression made out of letters
or other characters to denote some sort
of emotion or other expression.  You
view smileys by tilting your head to
the side.  :-) is an example of a
“happy” smiley.

snail mail
An Internet term for postal mail because
it takes so long, compared to email.

soc.
Name for the social-related set of
newsgroups.

spam
Spam is unsolicited email or news-
group postings.  Oftentimes, it’s simply
advertising.  It’s typically looked upon
as similar to junk mail or to unsolicited
phone marketing calls, and is usually
considered rude.



spamming 
Blatant advertising or the posting of
off-topic messages to newsgroups or
emailboxes, after which a flame war
usually erupts, resulting in more
spamming.  Spamming disrupts the
usefulness of the Internet.  Sending
spam is bad.

suffix
The set of letters after a “.” in a file-
name, hostname, etc.  In the name
earthlink.net, “net” is a suffix.
In the filename index.html,
“html” is a suffix.

surf
To spend time, often hours on end,
traveling through the Internet.

TCP/IP
Abbreviation for Transmission Control
Protocol/Internet Protocol.  TCP/IP 
is a way for computers to communicate
with each other over a network.
TCP/IP is the foundation technology 
of the Internet.

thread
A topic of discussion in a Usenet
posting or, less commonly, an 
email message.

TotalAccess
The software and Internet access pack-
age supplied by EarthLink Network,
Inc.  TotalAccess gives you total access
to all of the resources on the Internet
with the best software and fastest
modem connections available.



unicycle
A really cool one-wheeled machine
used as an example in this book,
during the writing of which, the
author actually bought a unicycle
and learned to ride it.

Uniform Resource Locator  
URL for short.  A URL contains the
exact location of a file some-where
on the Internet, along with the format
that file is in.

URL
Abbreviation for Uniform Resource
Locator.

Usenet news
The official name of a part of the
Internet that allows you to participate
in about 15,000 different discussion
groups on every topic imaginable.

user
Anyone who uses the Internet.

username
The name of a particular user on a
host, or server, computer.  Your user-
name is the name before the “@” sign
in your EarthLink email address.

Web
Abbreviation for World Wide Web.

Web page
A document on the Web that can be
displayed by your Web browser.

Web site
A particular “place,” or set of pages,
on the Web.



World Wide Web
Web for short.  The part of the Internet
that allows you to navigate through all
kinds of graphical information.  To view
the Web, you’ll use a Web browser,
which is supplied by EarthLink within
your TotalAccess package.

Information on the Web is formatted
into “pages.” Each page contains some
text and possibly pictures, sound or
even video.  A page is actually a file
stored on a remote computer some-
where on the Net.
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Congratulations, 
You Made It! 

Now that you’ve read through this electronic guide, you’re equipped to embark
on your own journey through the Internet for professional growth, personal
enrichment, or both. The Internet is a fantastic place. It can turn your home or
office computer into a portal to the entire world. I’ve seen it change people’s lives
in ways I never thought possible, and I
believe it is changing the world as well.
Never before have ordinary individuals
had such an effortless, powerful com-
munications medium at their disposal.

I hope this guide has provided you with
some of the rules of the road and helpful
tips to make your journey a pleasant one.

To leave this electronic guide, go to the 
File menu and choose Quit.

Good job!
Knowledge is

power; use
it well.
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